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Edith Documentation Overview

Introduction

What Edith Is

What Edith Is Not

Objects

People 

SimAntics

========== Exhaustive list of ideas:

Objects
 Object Properties
 Relationship Matrix
 Strings

People
 Person Properties
 Personality
 Astrological Sign
 Motives and Mood
 Skills
 Relationships
 Happy Weights
 Biographies
 Action Queue

SimAntics
 Virtual Machine
 Tree Code
 Tree Tables

Autonomy
 Motive Satisfaction
 Advertisements
 False Advertising
 Happyscape
 Happyness Contribution Curves
 Ad Attenuation
 Exit Conditions
 Food Chain
 Interaction Queue
 Priority Interactions
 User Control

Object Animation

Character Animation

Suits
 Heads
 Hands
 Bodies
 Accessories

SymAntics Programming
 Primitives
 Subroutines
 Return Values
 Parameters
 Comments
 Tree Properties
 Tree Tracing
 Tree Debugging
 Tree Breakpoints

Routing
 Routing Slots
 Doors

Simple Object Interactions

Social Interactions

Misc
 Tuning Variables
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 Conversation Topics
 Thought Balloons
 Dreaming
 Group Activities
 Jealousy
 Privacy
 Careers
 Work
 School
 Money
 Depreciation
 Services
 Bills
 Disasters
  Fire
  Theft
  Floods
  Sickness
 Portable Objects
  Carrying Accessories
  Carrying Objects
  Carrying Animations
 Censorship
 Invisibility
 Standard Heights
 Surfaces
 Chairs
 Room Scoring
 Terrain
 Water
 Pools
 Setting Up Lots
 Levels (upstairs/downstairs)
  Stairs
  Multi Tile Objects spanning levels
 Catalog Entries
 Cleaning
 Maintanence
 Gardening
 Lighting
 Shadows
 Time and Simulation Speed
 Neighborhood
 House
 Family
 Friendship and Romance
 Babies
 Moving In
 Death
 Ghosts
 Kids
 Visitors
 Neighbors
 Non Player Characters
 Stalker Cam
 Music
 Sound Effects
 HIT Files
 Vocals
 Action Icons
 Object Icons
 Conversation Icons
 Event Log
 Lighting Tweaker
 Object Dialogs
 Animation Tables
 CST Files
 Body Strings
 UI Text
 Walking
 Skill Lookup
 Resource Files
  Global Resource Files
  Semi Global Resource Files
  Object Resource Files
  Other Resource Files
 Coordinate Systems
 Draw Groups
 Family History
 Rooms
 GUIDs
 Interactions
 Loading and Saving
 Missing Objects
 Motive Curves
 Motive Effects
 Single Tile Objects
 Multi Tile Objects
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 Object Categories
 Object Placement Constraints
 Object Function Tables
 Routing
 Logging
 Suit and Skin and Outfit Organization
 Zodiac
 Slots
  Object Slots
   Standard Heights
    kHeightUndefined=0,
    kHeightGround,
    kHeightLowTable,
    kHeightTable,
    kHeightCounter,
    kHeightNonStandard,
    kHeightHand,
    kHeightSitting,
    kHeightEndTable
  Sprite Slots
  Routing Slots
 Performace Logs
 Picture In Picture
 Scrapbook
 Tree Constants
 Portals
  Doors
  Windows
  Stairs
  Ladder
  Diving Board

Edith User Interface Roadmap

 Modes
  Live Mode
  Buy Mode
  Build Mode

 Keyboard
  Type "e" to bring up the main "Edith" dialog.
  Type "m" to get more money, and "M" to lose money.

 Cheats

 Dialogs

  "Edith" Dialog
   From Sims Window, type "e".
   To "Animation Browser" Dialog.
   To "Find Objects" Dialog.
   To "Neighborhood" Dialog.
   To "Object Browser" Dialog.
   To "Object Inspector" Dialog.
   To "Object Profile" Dialog.
   To "Resource Editor" Dialog.
   To "Room Map" Dialog.
   To "Save Behaviors As Text" Dialog.
   To "Sim Loop Profile" Dialog.
   To "Simulation Constants" Dialog.
   To "Simulation Globals" Dialog.
   To "Strings" Dialog.
   To "Suspend Files" Dialog.
   To "Terrain Tweak" Dialog.
   To "Tree Search" Dialog.

   Menus
    File
     New
      Non functional. Don't use.
     Open...
      Non functional. Don't use.
     Save
      Non functional. Don't use.
     Save As...
      Non functional. Don't use.
     Save All Behaviors => "Save Behaviors As Text" Dialog
      Very interesting. Dumps out all tree programs as text you can 
read through. 
     Suspend Files... => "Suspend Files" Dialog
      Useful when installing a new version of a file while running the 
game.
     Print
      Non functional. Don't use.
     Print Preview
      Non functional. Don't use.
     Print Setup
      Non functional. Don't use.
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     Exit
      Just closes Edith main window. Type 'e' to get it back.
    Edit Menu
     Undo
      Non functional. Don't use.
     Cut
      Non functional. Don't use.
     Copy
      Non functional. Don't use.
     Paste
      Non functional. Don't use.
    View Menu
     Toolbar
      Toggles tool bar at top of window.
     Status Bar
      Toggles status bar at bottom of window.
     Switch Node Style
      Changes node style displayed in code view. Doesn't draw check 
mark. 
    Window Menu
     New Object Browser => "Object Browser" Dialog
      Very useful. Actually browses object classes. 
     New Reference Window => "Reference Window" Dialog
      Not very useful. Browses raw string resources.
      Not needed now that interface has improved.
     Tree Search... => "Tree Search" Dialog
      Very useful. Search all trees for a string.
      Double click on found strings to bring up code editors.
     Function Search... => "Find Objects" Dialog
      Very useful. Search for objects with special functions. 
      Brings up function table editor.
    Help
     Help Topics
      Non functional. Don't use.
     About Edith
      Shows the About Edith box.
    Sims
     Show Module Inspector => "Object Inspector" Dialog
      Very useful. Lets you look at any live object.
     Sims Global Dialog => "Simulation Globals" Dialog
      Very useful. Lets you view and change simulator globals. 
     Edit Constants
      Motive Sim => "Simulation Constants" Dialog
       Very useful. Lets you view and change simulator motive 
constants. 
      Autonomy => "Simulation Constants" Dialog
       Very useful. Lets you view and change simulator autonomy 
constants. 
      Room Score => "Simulation Constants" Dialog
       Very useful. Lets you view and change simulator room 
score constants. 
      Neighborhood => "Simulation Constants" Dialog
       Very useful. Lets you view and change simulator 
neighborhood constants. 
     Other Dialogs
      Neighborhood => "Neighborhood" Dialog
       Very useful. But hard to use. Lets you examine and edit 
the families and relationships in the neighborhood. 
      Animation Inspector => "Animation Browser" Dialog
       Very complicated. 
       Can journal and play back composite animations. 
       Suit and animation browser. 
       Allows low level control over animation mixing, for 
diagnosing glitches.
       Not very useful except for debugging character 
animation. 
      Terrain Tweaker => "Terrain Tweak" Dialog
       Not very useful. 
       Lets you tweak parameters of the terrain color table and 
grass blade drawing code.        
      Room Map => "Room Map" Dialog
       Interesting but not very useful. 
       Shows a flat map of the rooms. Use for debugging room 
code. 
      Object Profile => "Object Profile" Dialog
       Not very useful. 
       Complicated and hard to explain. 
       Used to profile the execution time of objects in the 
game, for optimization. 
      Sim Profile => "Sim Loop Profile" Dialog
       Not very useful.
       Hard to explain.
       Used to profile the execution time of the main simulator 
loop. 
     Show Special Objects
      Shows the special objects like the pedestrian portal, that are 
usually invisible.
     Hide Special Objects
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      Hides the special objects, that should usually be invisible. 
     Reload Careers File...
      Reloads the careers file. Not very useful. 
      Need to document careers separately. Not easy to change. 
     Edit Global Strings File
      Not very interesting. 
      These menu items bring up various string editors, which are 
pretty hard to use. 
      Careers => "Strings" Dialog
      Build => "Strings" Dialog
      Live => "Strings" Dialog
      UIText => "Strings" Dialog
      Credits => "Strings" Dialog
   Tool Bar
    New
     Non functional. Don't use.
    Open
     Non functional. Don't use.
    Save
     Non functional. Don't use.
    Cut
     Non functional. Don't use.
    Copy
     Non functional. Don't use.
    Paste
     Non functional. Don't use.
    Print
     Non functional. Don't use.
    About
     Shows the About Edith box.
    Help
     Non functional. Don't use.
    Object Browser => "Object Browser" Dialog
     Very interesting. Actually a class browser. 
    Reference Window => "Strings" Dialog
     Not very useful. Browses raw string resources.
     Not needed now that interface has improved.
    ResEdit Dialog => "Resource Editor" Dialog
     Interesting but not very useful. 
     Browse all resources at a low level. 
     Doesn't really let you edit. 

  "Animation Browser" Dialog
   From "Edith" Dialog.
   This is extremely complicated.
   It's used for debugging and finding glitches in character animations. 

  "Edit * Primitive" Dialogs
   From "Tree Editor" Dialog

  "Edit Behavior File" Dialog
   From "Object Browser" Dialog.
   From "Tree Editor" Dialog.
   To "Tree Editor" Dialog.
   To "Tree Search" Dialog.

  "Edit Function Table" Dialog
   From "Object Browser" Dialog.

  "Edit Object Definition" Dialog
   From "Object Browser" Dialog.

  "Edit Parameters" Dialog
   From "Tree Editor" Dialog.

  "Edit Tree Table" Dialog
   From "Object Browser" Dialog.

  "Find Object Dialogs" Dialog
   From "Object Browser" Dialog

  "Find Objects" Dialog
   From "Edith" Dialog.

  "Get String" Dialog
   From "Object Browser" Dialog.

  "Hex Resource Editor" Dialog
   From "Resource Editor" Dialog.

  "Neighborhood" Dialog
   From "Edith" Dialog.

  "New Object" Dialog
   ???
   IDD_NEW_OBJECT_DIALOG

  "Object Browser" Dialog
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   From "Edith" Dialog.
   From "Tree Editor" Dialog.
   To "Edit Behavior File" Dialog.
   To "Edit Tree Table" Dialog.
   To "Edit Object Definition" Dialog.
   To "Get String" Dialog.
   To "Edit Function Table" Dialog.
   To "Find Object Dialogs" Dialog.

  "Object Inspector" Dialog
   From "Edith" Dialog.

  "Object Profile" Dialog
   From "Edith" Dialog.

  "Relationships" Dialog
   ???
   IDD_RELMATRIX

  "Resource Editor" Dialog
   From "Edith" Dialog.
   To "Hex Resource Editor" Dialog.
   To "String Resource Editor" Dialog.

  "Room Map" Dialog
   From "Edith" Dialog.

  "Save Behaviors As Text" Dialog
   From "Edith" Dialog.

  "Set Typical Context" Dialog
   ???
   IDD_SETCONTEXT

  "Select Stack Object" Dialog.
   From "Tree Editor" Dialog.

  "Sim Loop Profile" Dialog
   From "Edith" Dialog.

  "Simulation Constants" Dialog
   From "Edith" Dialog.

  "Simulation Globals" Dialog
   From "Edith" Dialog.

  "String List Editor" Dialog
   ??? 
   IDD_REFERENCE_DIALOG and IDD_REFERENCE_DIALOG1

  "String Resource Editor" Dialog
   From "Resource Editor" Dialog.

  "Strings" Dialog
   From "Edith" Dialog.

  "Suspend Files" Dialog
   From "Edith" Dialog.

  "Terrain Tweak" Dialog
   From "Edith" Dialog.

  "Tree Editor" Dialog
   From "Edit Behavior File" Dialog.
   To "Edit Behavior File" Dialog.
   To "Object Browser" Dialog.
   To "Edit * Primitive" Dialogs.
   To "Edit Parameters" Dialog.
   To "Tree Properties" Dialog.
   To "Select Stack Object" Dialog.
   Menus
    Object
     Browse Object... => "Object Browser" Dialog.
     Browse Tree... => "Edit Behavior File" Dialog.
    Edit
     Cut
     Copy
     Paste
     Delete
     Undo
     Redo
     Node Parameters... => "Edit Parameters" Dialog.
     Called Tree...
     Comment...
     Auto Size
     Print Tree
     Properties... => "Tree Properties" Dialog.
     Stack Object => "Select Stack Object" Dialog.
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     Save
    Select
     All
     None
     First
     Next
     Previous
     True
     False
     First Caller
     Next Caller
     Above
     Below
     Children
     By Number...
    Stack
     Push
     Pop
    Move
     Left
     Right
     Up
     Down
     Page Left
     Page Right
     Page Up
     Page Down

  "Tree Properties" Dialog
   From "Tree Editor" Dialog.
  
  "Tree Queue" Dialog
   ???
   IDD_TREEQUEUEDIALOG

  "Tree Search" Dialog
   From "Edith" Dialog.
   From "Edit Behavior File" Dialog.

  "Tree Tracer" Dialog
   ???
   IDD_TRACER


